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YOU SHOULD CAREFULLY READ THE FOLLOWING END USER LICENSE AGREEMENT BEFORE
INSTALLING THIS SOFTWARE PROGRAM.

This software program, any printed materials, any online or electronic documentation, and any and all copies and derivative

works of such software program and materials (the “Program”) are the copyrighted work of Davidson & Associates, Inc. All use of

the Program is governed by the terms of the End User License Agreement which is provided below ("license”]. The Program is solely
for use by end users according to the terms of the License Agreement. Any use, reproduction or redistribution of the Program not in
accordance with the terms of the License Agreement is expressly prohibited.

END USER LICENSE AGREEMENT

1. Limited Use License. Davidson & Associates, Inc. (“Davidson’) hereby grants, and by installing the Program you thereby
accept, a limited, nonexclusive license and right fo install and use one (1) copy of the Program for your use on either a home
or portable computer.

2. Ownership. Al file, ownership rights and intellectual property rights in and fo the Program and any and all copies thereof
[including but not limited to any fitles, computer code, themes, objects, characters, character names, stories, text, dialog, catch
phrases, locations, concepts, artwork, animations, sounds, musical compositions, audiovisual effects, methods of operation,
moral rights, any related documentation, and “applets” incorporated info the Program| are owned by Davidson or its licensors,
The Program is protected by the copyright laws of the United States, infernational copyright treaties and conventions and other
laws. Al rights are reserved. The Program may contain certain licensed materials, and Davidson’s licensors may act o profect
their rights in the event of any violation of this Agreement.

3. Responsibilities of End User.

A. Subject fo the Grant of License hereinabove, you may not, in whole or in part, copy, photocopy, reproduce, franslate,
reverse engineer, derive source code from, modify, disassemble, decompile, or create derivative works based on the
Program, or remove any propriefary nofices or labels on the Program without the prior consent, in writing, of Davidson.

B. The Program is licensed fo you as a single product. lts component parts may not be separated for use on more than one
computer.

C. You are entifled o use the Program for your own use, but you are not entiled to:

[i) sell, grant a security inferest in or transfer reproductions of the Program fo ofher parties in any way, nor to rent, lease or
license the Program fo others without the prior writien consent of Davidson;

[ii) exploit the Program or any of its parts for any commercial purpose including, but not limited fo, use at a cyber café,
computer gaming center or any other locationbased site (Davidson may offer a separate Site License Agreement fo
permit you to make the Program available for commercial use; contact Davidson for details); and

[iii) host or provide matchmaking services for the Program or emulate or redirect the communication protocols used by
Davidson in the network feature of the Program, through protocol emulation, tunneling, modifying or adding compor
nents fo the Program, use of a utility program or any other techniques now known or hereafter developed, for any
purpose including, but not limited to, network play over the Inernet, network play uilizing commercial or noncommer-
cial gaming networks, or as part of content aggregation networks without the prior written consent of Davidson.

4. Program Transfer. You may permanently fransfer all of your rights under this License, provided the recipient agrees to the terms
of this License and you agree to remove the Program from your home or portable computer.

5. Termination. This License is effective unfil terminated. You may ferminate the license af any time by desfroying the Program.
Davidson may, at s discrefion, terminate this License in the event that you fail o comply with the terms and conditions i

contained herein. In such event, you must immediately destroy the Program ‘

]
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Export Controls. The Program may not be re-exported, downloaded or otherwise exported info (or fo a national or resident of)
any country fo which the U.S. has embargoed goods, or fo anyone on the U.S. Treasury Department’s list of Specially
Designated Nationals or the U.S. Commerce Department’s Table of Denial Orders. By installing the Program, you are agreeing
to the foregoing and you are representing and warranting that you are not located in, under the control of, or a nafional or
resident of any such country or on any such list.

. Limited Warranty. DAVIDSON EXPRESSLY DISCLAIMS ANY WARRANTY FOR THE PROGRAM AND MANUAL(S). THE PROGRAM AND

MANUAL(S) ARE PROVIDED “AS IS WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANITIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT.
DAVIDSON FURTHER DISCLAIMS ALL WARRANTIES WITH REGARD TO YEAR 2000 COMPLIANCE OF THE SOFTWARE SPECIFICALLY,
DAVIDSON MAKES NO WARRANTIES THAT THE PERFORMANCE OR FUNCTIONALITY OF THE PROGRAM WILL NOT BE AFFECTED
BY DATES PRIOR TO, DURING OR AFTER THE YEAR 2000, OR THAT THE PROGRAM WILL BE CAPABLE OF CORRECTLY PROCESSING,
PROVIDING, AND,/OR RECEIVING DATE INFORMATION WITHIN AND BETWEEN CENTURIES, INCLUDING THE PROPER EXCHANGE
OF DATE INFORMATION BETWEEN PRODUCTS OR APPLICATIONS. ANY WARRANTY AGAINST INFRINGEMENT THAT MAY BE
PROVIDED IN SECTION 2-312(3) OF THE UNIFORM COMMERCIAL CODE AND/OR IN ANY OTHER COMPARABLE STATE STATUTE IS
EXPRESSLY DISCLAIMED. The entfire risk arising out of use or performance of the Program remains with you, however Davidson
warrants the Master Disk(s], on which the Program is furnished, to be free from defects in materials and workmanship, under
normal use, for a period of ninety (90) days from the date of delivery. Davidson’s sole liability in the event of a defective disk
shall be to give you a replacement disk. Some states do not allow the exclusion or limitation of incidental or consequential
damages, or allow limitations on how long an implied warranty lasts, so the above limitations may not apply.

Limitation of Lidbili'y. NEITHER DAVIDSON, ITS PARENT, SUBSIDIARIES, AFFILIATES OR LICENSORS SHALL BE LIABLE IN ANY WAY
FOR LOSS OR DAMAGE OF ANY KIND RESULTING FROM THE USE OF THE PROGRAM INCLUDING, BUT NOT LIMITED TO, LOSS
OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES
ORLOSSES. Some states do not allow the exclusion or limitation of incidental or consequential damages, or allow limitations on
how long an implied warranty lasts, so the above limitations may not apply fo you.

. Equitable Remedies. You hereby agree that Davidson would be imeparably damaged if the terms of this License were not

specifically enforced, and therefore you agree that Davidson shall be entifled, without bond, other securily, or proof of
damages, to appropriate equitable remedies with respect o breaches of this License, in addition to such other remedies as
Davidson may otherwise have available fo it under applicable laws.

. Miscellaneous. This License shall be deemed to have been made and executed in the State of California, and any dispute

arising hereunder shall be resolved in accordance with the law of the State of California. This License may be amended,
alrered or modified only by an instrument in writing specifying such amendment, alieration or modification executed by both
parties. In the event that any provision of this License shall be held by a court or other tribunal of competent jurisdiction to be
unenforceable, such provision will be enforced fo the maximum extent permissible and the remaining portions of this License
shall remain in full force and effect. This License constitutes and contains the enfire agreement between the parties with respect
o the subject matier hereof and supersedes any prior oral or wriften agreements. This License is the complete and exclusive
statement of the agreement between the parfies hereto, and this License supersedes any prior or contemporaneous agreement,
either oral or writlen, and any other communications between the parties hereto.

lyping Tutor and Letter Invaders are registered trademarks and Time Response Monitoring and Natural Language Generator are
rademarks of Simon & Schuster, Inc. Windows is a registered trademarks of Microsoft Corporation. Macintosh is a registered
lrademark of Apple Computer, Inc. PowerPC is a registered frademark of International Business Machines Corporation.



Welcome to _Cyping Tutor Platinum

Windows® Sys’rem Req uirements

v 486/66 MHz or faster with 16 MB of RAM
v Windows-compatible Multimedia sound card

v Hard disk with 1 MB free space
v Quad-speed CD-ROM drive
v SVGA card (256 colors)

v DOS 5.0 or higher
v Windows 3.1x, 95, or 98
v Printer (optional)

Jns’ra“ing and Running with Windows® 3.1x

Insert the Typing Tutor Platinum CD-ROM into your drive.

Select Run from the File menu in Windows Program Manager.
Type d:\setup and press ENTER. (If your CD-ROM drive is not d, type
the appropriate letter.)

Follow the instructions on the screen. A directory called Typtutor
will be created on your hard disk, where your personal data files
for this program will be stored.

A new icon and a Typing Tutor Platinum program group will be
created.

With the CD in the drive, from the Program Manager, find and
open the Typing Tutor Platinum program group and double-click
the Typing Tutor Platinum icon.

© 1998 Simon & Schuser, Inc., the publishing operation of Viacom, Inc. and
Davidson & Associates, Inc. All rights reserved.
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Jnsfa”ing and Ruww\ing with Windows® 05/98

Insert the Typing Tutor Platinum CD-ROM into your drive. Setup
will start automatically if AutoPlay is enabled. Note: If AutoPlay is
not enabled, select Start and then Run from the Windows Taskbar.
Type d:\setup and press eNTER. (If your CD-ROM drive is not d, type
the appropriate letter.) The install process will automatically begin if
a previous install isn't detected.

With the CD in the drive, select Run Typing Tutor Platinum from
the main option screen if Autoplay is enabled. Note: If AutoPlay is
not enabled, click Start on the Windows Taskbar.

Select Programs and then Typing Tutor Platinum.

NENEN

Macintosh® System Requirements
PowerPC® with 16 MBof RAM v/ Monitor with 640 x 480 display
System 7.5.1 or higher v Quad-speed CD-ROM drive
256-color capability v Printer (optional)

Jns’ra”ing and Runhing on the Macintosh®
Insert the Typing Tutor Platinum CD into your drive and double-click
the TTPlatinum Installer icon.

Click Continue and follow the instructions on the screen.
To run the program, make sure the CD is in the CD-ROM drive, then
double click the TTPlatinum icon.
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GeHiV\g Started

Congratulations! You are ready to begin improving your typing
NOW! If you are already a touch typist and want to improve your
speed and accuracy, go directly to the Typing Tutor module and
register as a new student.

If you are a beginning student, you have two choices:

1. Go directly to the CETM module and learn the whole keyboard
in ten sequential lessons, each devoted to a specific finger. You
can concentrate on building skills one finger at a time with this
revolutionary new method. Each lesson is 20 minutes long,
broken into four 5-minute sessions. You may change the length
of a given session by accessing Lesson Time from the File
menu. When you finish the CETM module, you may review
any of the lessons if you wish. Then you will go to the Typing
Tutor module to build speed and accuracy.

2. Go directly to the Typing Tutor module and register as a begin-
ning typist. Use the traditional "home row” lessons to learn the
whole keyboard. The standard home row method of teaching
typing (with all fingers involved immediately) has been suc-
cesstul for thousands of people throughout the years.

Whichever method you choose, we suggest that you continue

with it until you have learned the whole keyboard.
4

Typing Tutor Module

You may register as a New Student, Continuing Student, or Visitor.

To register as a New Student:

e Click the New Student button and enter your name in the
dialog box.

¢ Click the Preferences button to see the many options available
(or select Preferences at any time from the File menu).

* Click the appropriate level in the Experience box, and then set
your typing speed goal.

* Indicate where you wish to save your Typing Tutor history file.

You may be asked to take a short diagnostic test to precisely deter-

mine your current speed and accuracy. You may take a practice

test first or go directly to the initial diagnostic test. (You can take

the diagnostic test later by selecting it from the Progress menu.)

To register as a Continuing Student:
¢ Click the Continuing Student button.
* Select your name from the list of continuing students.

To register as a Visitor:
¢ Click the Visitor button. (Your record will not be saved.)

U



|l essons and Tests

Bookshelf Progress

SI’\OW _Eime

GOIVV\ES

Tutor Smggesfions

This is the Typing Tutor main screen. From here, you can go
anywhere in the program. You will always find comments here
from your personal, on-line typing coach: Based on your current
ability level and the results of your last activity, Typing Tutor will
recommend which exercises you should do next. To take one of
the tutor’s suggestions, just click the arrow beside an assignment.
To plan your own program, click one of the five activity icons on
the screen.

L essons and Tests
Access a lesson by clicking the stopwatch icon (or clicking
one of the lesson assignments the tutor has suggested for you).

Notice the keyboard at the
top of the lesson screen.
The keys and fingers are
color-coded to show the
keys typed by each finger.
The shadow hands are
resting on the keyboard

in the home row position,
ready to show you the keys
to press for the first keystroke of the lesson. As you continue the
lesson, the shadow hands animate and will demonstrate proper
finger positioning for each new character before you type it. You
can turn off the keyboard or hands, or choose another screen
layout for your lesson by selecting Preferences from the File menu.

frother stockbroker (stalling beside a castle) exounerates. Vhich olock

is inprecise - the digital vateh or the chronometer? Prefer - aninal
(tick). vegstable {smartveed). and minersl (bondstone). Use s wachine
(compressor. sprayer. or grader) or & tool (plastering trovel.
dividers. cr planer). A velder (describing in another solf course)

telsvisest Use & aschine (csx engine, ssv machine, or adding mschine}

Your lesson appears in black text in the box below the keyboard

diagram. As you type, your text will appear in blue. The text

smoothly scrolls in time with your personal typing speed. Your

errors will be shown in red; you may backspace to correct these

errors unless you have turned off the backspace option. To hear
%



pacing music as you type, choose one of the five songs from the
Sound menu. You can adjust the tempo of the music by choosing
Faster or Slower from the Sound menu. When you finish the les-
son, you will be returned to the
main screen where the tutor will
offer new, personalized sug-
gestions based on the results

of your lesson. Custom lessons
offer further choices for specific
focus. Select Custom from the
Lessons menu or click the stop-
watch icon, and then choose
Custom Lesson options.

Lasts
The Typing Tutor tests look and function like the lessons, except for
two things:
1. You cannot design a custom test by row, hand, or finger.
2. New letters and characters are never introduced during a test.

Choose Regular from the Tests menu, or click the stopwatch icon
and select Test from the options dialog box. You can also select a
custom test from the menu or dialog box

8

py‘og ress
Click the graph icon to check on your typing progress.
From this one screen, you may view various speed and accuracy
graphs, and a progress report.

Compare
your most
recent test
with your
entire test
history.

To return to the

Print your graphs and reports by clicking ‘
main screen, click @ ;

Bookshelf

Typing Tutor offers over 100 interesting book excerpts from
a wide variety of categories to use for your typing practice. Not
only will you be getting in some good keyboard practice, but at
the same time, you'll get to read about whatever interests youl

9



The Bookshelf feature also
offers dictation, note-taking
practice, and an alphabet-
ized library listing of all the
books used. Click the Book-
shelf icon (or open the Book-
shelf menu) and select a
category that interests you.
Next, from the browser screen, choose a specific book from the
category you have selected. Click a title in the scroll box, and you
will see the book cover and an excerpt from that book. Scroll to
read the excerpt if you wish, then click the Begin Test button at the
bottom of the screen to begin typing the text.

Dictation and ]\]o’re-Taking
In case you'd like to practice your dictation and note-taking typing
skills, Typing Tutor offers 18 book excerpts which are read aloud to
you for these purposes. You can access these excerpts from the
Dictation Typing category of the Bookshelf.

Remember, you won't be seeing any preprinted text in the dicta-
tion mode! Once you click the Begin Test button, the excerpt will
be read aloud to you. You may begin typing at any time. You may

10

also pause the dictation activity by pressing ESC or TAB in order to
control the pace. When you click ESc or 1aB a second time, the
dictation will back up three seconds and then resume. You may
type the complete text or just take notes on the important points.

Business Letters
Choose this Bookshelf category for a selection of useful business
letters. These letters are also available as text files for you to adapt
and use with any standard word-processing program. They are in
a separate Typing Tutor folder called Business Letters.

Disk File
You can import any text file to [Please ch
use for your typing practice.
* Select the Disk File option - L

from the Bookshelf menu
or category screen, then
access the text file from
this dialog box.

* Click on the TTWebsite icon -
in the program group or folder to download additional typing
passages from our web site, typingtutor.com.

1)



Library List
The final option in the Bookshelf feature is the Library List. As you
use the book excerpts for typing practice, you may want to find
out more about the books themselves. The Library List offers an
alphabetical listing of each Simon & Schuster book title included
in Typing Tutor. The ISBN numbers and book summaries are
provided for you. Click the Library List button (or choose Library
List from the Bookshelf menu) to view the library listing.

Show Time

Typing Tutor offers over 100 video selections with related
typing practice. You can view video clips from many different
categories such as sports, entertainment, and history.

¢ C(Click the film icon on the
main screen to access
Show Time, and select a
movie category. (Or select
a category from the Show
Time menu.)

Select a video clip from the Show Time browser screen. Click a
title in the scroll box, and you will see a still shot from the movie

2

accompanied by a rela-
ted passage. Scroll to
read the passage first if
you wish, then click the
Begin Test button at the
bottom of the screen.
When you finish typing
the passage, the movie
e e — will play. To see it again,
o : click Play Video Again.

Games
Typing Tutor offers three different games to challenge
your typing skills in an exciting and entertaining way.

® Click the joystick icon
on the main screen
to access the game
selection screen, or
choose a game from
the Games menu.

5]



1. Letter Invaders
This fast-moving game challenges you to type the “invading”
letters and words before they touch the ground. Each scene will
show words falling from the sky. You must type each word accu-
rately before it touches the ground in order to launch one of your
missiles and destroy the letter invader. If you don't type fast
enough, the invader will explode and destroy part of your city. It's
easy to keep up at first, but the letters will come faster and faster.

How long can
you protect
your city and
keep the alien
game going?

14

2. Word Search

The traditional word search now becomes an exciting, fast-paced
game! Your challenge is to locate and type the words hidden
within the grid as fast as you can. Each word search is based on a
different theme and randomly generated, so you'll see a new
puzzle each time. Click @] at the bottorn left of the screen to sam-
ple a few of the word search themes. Choose one and start typing
in the words you find, pressing ENTER or RETURN after each one.
When time expires, any words you haven't found will Pop up in
red. You can choose from three levels of difficulty and set your
own time limit. (Choose Preferences from the File menu.)

3. Whack ‘Em

" There's an age-old game found at arcades and carnivals,
where little plastic objects rise out of grid holes, and the player
tries to hit them on the head before they pop back into their A
holes. Whack ‘Em is played the same way, except you must

type the word before the critter creeps back into its hole!l When the
first critter and word appear, begin typing to start the game. If you
type quickly and accurately, you'll “whack” the 4~ critters and
enjoy their surprised reactions! Your goal in . this game
is to reach the "ultimate” opponent. Don't WOITY,
you'll know him when you see him! :
{5
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prefe rences
Typing Tutor can be customized to fit your needs. Select Prefer
ences from the File menu and make your selections.

Lesson and Test Op’rions

Keyboard
Type
Goal
Word
S h
Student Gi:::g
Name Opfions

Jnstructonr Mode
The Instructor Mode allows a teacher to monitor both individual
and group student progress. Progress reports, speed graphs, and
composite reports can be displayed and printed. Additionally,
personal high game score list will be maintained for each student
and can be accessed from the Game menu.
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Before You Call Technical Support

Please have the following information ready when you call:

Windows® 95 or 98

. Product name and version number (on the CDJ of the product.-

. The processor and clock speed fe.g., 486,/66) of your computer.

. Your operating system’s version number. :

- The brand name of the sound device installed in the computer.

The amount of free memory (memory available fo run the program| you
have. {In Windows 3.1x, go fo the Program Manager from the Help
menu; in Windows 95,/98, open Explorer on the desktop and select
About Windows 95,/98 from the Help menu.] From the dialog box that
appears, write down the Memory and System Resources values.

6. The complete and exact error message reported by the program (if any).
/. A printout of your config.sys and autoexec.bat files.

Macintosh®

I Product name and version number (on the CD) of the product.

2. The model name of your Macintosh and the system version number. (See
About This Computer on the Apple Menu.|

G W —

Technical Suppor’r
Support outside U.S. and Canada via fax, mail, and World Wide Web only.
Phone: (800) 457-8357 7av—6pm Pacific Time, M—F
Fax: (818) 246-5604
World Wide Web: http:/ /www.KnowledgeAdventure.com
Mail: Knowledge Adventure, Inc., 4100 W. 190th St., Torrance, CA 90504
072798



User’s Manual
Inside

Technical Support:
(800) 457-8357

Knowledge Adventure, Inc.
4100 West 190th Street
Torrance, CA 90504

Internet
www.KnowledgeAdventure.com

Published jointly by Davidson & Associates, Inc.
and Simon & Schuster, Inc., the publishing
operation of Viacom, Inc. © 1998 Simon &
Schuster, Inc., the publishing operation of Viacom,
Inc. and Davidson & Associates, Inc. All rights
reserved. Typing Tutor® and Letter Invaders® are
registered trademarks and Time Response
Monitoring™ and Natural Language Generator™
are trademarks owned by Simon & Schuster, Inc.
Conceptual Effects Typing Method?® is a registered
trademark and CETM™ and JoeBis™ are
trademarks of JoeBis Publishing. Microsoft ™

and Windows™ are trademarks of Microsoft
Corporation. Macintosh® is a registered trademark
and Power Macintosh™ is a trademark of Apple
Computer, Inc. Used under license.

Your Satisfaction
is Guaranteed

We are so sure that you will be completely
delighted with your Knowledge Adventure/Simon
& Schuster purchase that we offer a 30-day 100%
SATISFACTION GUARANTEE. If for any reason
you are not completely satisfied with this product
return it to us along with a copy of your purchase
receipt to the address listed under Technical
Support within 30 days of purchase.We will gladly
exchange it for a product of equal or lesser value
or refund your money.

Dealers, distributors and their employees are not eligible.

DON’'T FORGET!

Register this product
to receive product update
information and technical

support notices.

ﬁ Knowledge

Adventure’

4 SIMON &

RRCIUENEY  0671-31791-
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